
PASIÜLYMAS

(2018-ESO-404) 10 KV SF6 (LLTS KONFIGURACIJOS)SKIRSTYKLOS PIRKIMUI

1. TNFORMACTJA AP]E TIEKËJA

UAB ABBTiekejo pavadinimas / Tiekejq grupès nariq pavadinimai

Tiekejq grupes bendras atstovas arba vadovaujantis
narys (pildoma, jei pasiülymq teikia Tiekejq grupê)

2. SUTTKTMAS SU PIRKIMO SALYGOMIS

PaZymime, kad pateikdami savo Pasiùlymq, sutinkame su Pirkimo sqlygose (kaip jos apibrèZtos Bendrosiose pirkimo
sqlygose) nustatytomis tolesnêmis Pirkimo procedüromis ir brlsimos Sutarties sqlygomis (tiek bendrqla, tiek specialiqja
dalimis).

Patvirtiname, kad atidZiai perskaitême visus Pirkimo sqlygrl, taip pat ir Technines specifikacijos, reikalavimus, mrJsq
Pasiülymas juos visiökai atitinka ir jsipareigojame jq laikytis vykdydami Sutartj. Taip pat jsipareigojame laikytis ir kitq
Lietuvos Respublikoje galiojanöiq ir Pirkimo objektui bei SutarÕiai taikomq teisês aktq reikalavimq. Rengdami Pasiúlymq,
atsiZvelgeme j darbq saugos ir darbo sElygLl reikalavimus.

Jei bûsime kvieöiami sudaryti Sutarti ir atsisakysime jq sudaryti, isipareigojame, lgaliojusiai organizacijai pareikalavus,
sumoketilgaliojusiaiorganizacijai '10 proc. Dalyvio Galutinio pasiûlymo kainos EUR be PVM dydZio baudq bei padengti

lgaliojusios organizacijos patirtus tiesioginius nuostolius, kiek jq nepadengia aukööiau nurodyta bauda. Tiesioginiais
nuostoliais bus laikomas kainos skirtumas tarp Sutartl atsisakiusio pasiraËyti Dalyvio Galutinio pasiülymo kainos EUR
be PVM ir kito Dalyvio, pasiülymq eileje esanöio po atsisakiusio sudaryti sutartj Dalyvio, Galutinio pasiúlymo kainos
EUR be PVM.

3 TNFORMACTJA AptE pLANUOJAMUS pAS|TELKTTSUT|EKËJUS AR RËM|MASr KrrU ÜXrO SUe¿EKTU
PAJEGUMAIS

Sutarties vykdymo metu bus remiamasi ðiq ükio subjektq pajegumais:3.1

Pirkejui papraöius, pateiksime kio subjektq, kuriq pajegumais remiamasi, deklaracijq, uZpild ytr¿

üt<io
pagal Pasiülymo
subjektu Pirkejoformos Priede Nr. 4 pateiktq formq, skaitmenines kopijas, patvirtinanöiais sutikimq büti Tiekejo

atliekamame Pirkime.

1 Nurodomas konkretus Ükio subjekto pavadinimas, jei Zinomas Pasiülymq pateikimo metu. Jei ketinama pasitelkti, taciau konkretus
pavadinimas nêra 2inomas, nurodoma,,neZinomas".
2 Toks perdavimas nekeiöia pagrindinio Tiekejo atsakomybés dèl numatomos sudaryti Sutarties ivykdymo.

Eit

Nr
Ükio subjekto, kurio pajegumais nesiremia,

pavadinimasl (Subtiekejai arba Ükio subjekto
(specialistai), kurie nèra Tiekejo darbuotojai

Sutarties objekto dalies, perduodamos vykdyti ükio
subjektui, apra5ymas2

Pvz. Vardenis Pavardenis Pvz. Registrq analize1

2 Pvz. UAB,,XXX" Montavimo darbai



4. PAS]ÜLYMO KAINA

4.1

4.2

Pasiülymo kaina nurodoma eurais.

Pasiulymo kaina nurodoma u2pildant pateiktq lentelç:

5. PASIÜLYMO GALIOJIMO TERMINAS

Pasiülymas galioja BPS B.'1. punkte nurodytq terminq.

6. PRIEDAI PRIE PASIÜLYMO FORMOS

6.1 .

6.2.
6.3.
6.4.
6.5,

Priedas Nr. 1. Tiekejo rekvizitai ir kita informacija, I lapas;
Priedas Nr. 2. Konfidenciali informacrya, 2lapai,
Priedas Nr. 3. Prekiq atitikties techninés specifikacijos reikalavimams lentele, xx lapq.
Priedas Nr. 4. Deklaracija del sutikimo búti Subtiekêju, '1 lapas
Priedas Nr. 5. Deklaracija deljungtinei veiklai susivienijusiq tiekejq grupês dalyvavimo pirkime, 2lapai

PasiraËydamas ðl pasiülymq, tvirti visq kartu su pasiülymu pateikiamq dokumentq tikrumq.

Prokúristas 

jo igalioto asmens pareigos, vardas, pavardê, paraðas)s

asmens pareigos, vardas, pavardê, para5as)6

3 Kaina EUR be PVM apskaiðiuojama padauginant lkaini EUR be PVM ið kiekio.
4 Pasitilymo kaina EUR be PVM bus naudojama pasiulymq vertinimui. Pasiúlymo kaina EUR be PVM turi apimti visas iélaidas, visus mokesðius,
i5skyrus PVM mokesti, mokêtinus pagal galiojanðius Lietuvos Respublikos istatymus, jskaitant sqskaitq pateikimo ka5tus per,,E.sqskaita" sistemq.
5 Jei PasiûlymE Pirkimui pasiraöo vadovo jgaliotas asmuo, prie Pasiûlymo turi buti pridétas ra5ytinis jgaliojimas arba kitas dokumentas, suteikiantis
paraëo teisç.
6 Jei Pasiûlymq Pirkimui pasiraéo vadovo jgaliotas asmuo, prie Pasiülymo turi büti pridètas ra5ytinis igal¡ojimas arba kitas dokumentas, suteikiantis
paraËo teisç.

1 mato vieneto
ikainis EUR be PVM

E¡I.
Nr.

Pirkimo objektas Kiekis Sutarties galioj¡mo
laikotarpiu, vnt

Kaina EUR be
PVM3

1 10 kV SF6 (LLTs konfiguracijos)
skirstykla

1 4982.00 4982,00

Pasiülymo kaina EUR be PVMa 4982.00

PVM 1046.22

PasiÍilymo kaina EUR su PVM 6028.22



Tiekejo pavadinimas / Tiekejq grupes nariq pavadinimai UAB ABB

Tiekejo adresas(-ai)7 (jei skiriasi, taip pat nurodyti ir adresq
korespondencijai)

Parko 9.37, 1T14198 AviZieniq k., Vilniaus raj.

Juridinio asmens kodas(-ai)B (tuo atveju, jei Pasiülymq
pateikiq fizinis asmuo - verslo paZymejimo Nr. ar pan.)

110179684

Tiekejo PVM moketojo kodas(-ai)8 LT10l 7968't 1

Tiekejo / Tiekejq grupes bendro atstovo
vadovaujanöio nario sqskaitos numeris ir
pavadinimas

arba
banko

DE565007001 00850927500 Deutsche Bank

Tiekejo / Tiekejq grupês bendro atstovo arba
vadovaujanöio nario telefono numeris

Pasiûlymo pasira5ymui Tiekejo / Tiekejq grupes bendro
atstovo arba vadovaujanðio nario igalioto asmens vardas,
pavardê

Lapinskas

Pasiülymq pateikusio Tiekejo / Tiekejq grupês bendro
atstovo arba vadovaujanöio nario kontaktinio asmens
vardas ir pavarde

Pasiûlymq pateikusio Tiekejo / Tiekejq grupes bendro
atstovo arba vadovaujanöio nario kontaktinio asmens
telefono numeris / Mobilaus telefono numeris

Pasiûlymq pateikusio Tiekejo / Tiekejq grupês bendro
atstovo arba vadovaujanöio nario kontaktinio asmens
elektroninio paðto adresas

Sutarties vykdymui Tiekèjo / Tiekejq grupes bendro
atstovo arba vadovaujanðio nario jgalioto asmens vardas,
pavardê, tel. Nr., el. pa5tas.

Priedas Nr.1 prie Pasiülymo formos

TIEKEJO REKVIZITAI IR KITA INFORMACIJA

PASTABA: Jei pasiulymq pateikia Tiekejq gru Tiekejo rekvizitus ir kitq informacijq turi pateikti kiekvienas tokios grupês narys.

igalioto asmens pareigos, vardas, pavardè, paraöas)8

Prokûristas 

(Tie asmens pareigos, vardas, pavardê, paraðas)e

7 Tuo atveju, jei Pasiûlymq teikia Tiekéjq grupe, pateikiama informacija apie visus Tiekéjq grupes narius.
I Jei Pasiülymq Pirklmui pasira5o vadovo jgaliotas asmuo, prie Pasiûlymo turi büti pridêtas raéytinis jgaliojimas arba kitas dokumentas, suteikiantis
paraËo teisç.
e Jei Pasiûlymq Pirkimui pasiraöo vadovo jgaliotas asmuo, prie Pasiúlymo turi buti prideias ra5ytinis jgaliojimas arba kitas dokumentas, suteikiantis
paraSo teisç.



Priedas Nr. 2 prie Pasiùlymo formos

KONFIDENCIALI INFORMACIJA

Atkreipiame Tiekejq demesi, kad Zemiau lenteléie nurodvta Pasiülvmuose pateikiama informaciia bus vie5inama vadovaujantis vie5uosius pirkimus reglamentuojanciq
teisês aktq nuostatomis beiVieðqiq pirkimq tarnybos bei teismq formuojama praktika.

Pateikiamas dokumentas
vieðinimui (iðskyrus
informacijq, kurios
atskleidimas negalimas pagal
Asmens duomenq teisinés
apsaugos istatymq)12

TAIP

Pateikiamas dokumentas
skirtas Paraiðkos ir/ar
kvalifi kacijos atiti kimo
ivertinimuill

TAIP

TAIP

Vieéinimo pagrindas

Vieõinama vadovaujantis ir VPI 20 straipsnio 2
dalimi I Pl32 straipsnio 2 dalimi.

Vieõinama vadovaujantis VPI 20 straipsnio 2
dalimi/ Pl 32 straipsnio 2 dalimi, i5skyrus
informacijq, kurios atskleidimas negalimas
pagal Asmens duomenq teisinés apsaugos
jstatymq.

Vieðinama vadovaujantis VPI 20 straipsnio 2
dalimi/ Pl 32 straipsnio 2 dalimi, pateikta
informacija, isskyrus informacijq, kurios
atskleidimas negalimas pagal Asmens
duomenq teisinês apsaugos istatymq.

Vieðinama vadovaujantis VPI 20 straipsnio 2
dalimi/ Pl 32 straipsnio 2 dalimi, VPT ir teismq
formuojama praktika, iSskyrus jkainiq
sudedamqsias dalis.

Subtiekejo deklaracija del sutikimo büti subtiekeju

Prekiq irlar Paslaugq ikainiai

UZpildytos formos ir kita pateikiama
informacijalo

Pasiülymo forma (be priedq, bei Tiekejo fiuridinio
asmens) informacijq, nurodytq Ëios pasiülymo
formos 1 dalyje, kuri bet kokiu atveju negali bùti
laikoma konfidencialia informacija)

Tiekejo rekvizitai ir kita informacija

4

E¡I.
Nr.

1

2

J

konfidencialuma irodantvs dokumentai ir arqumentai.
11 Dokumentas ikeliamas: INSERT -> Object -> Create From File -> Browse -> Display as icon -> ok.

nêra konfidencialios ir negalimos vieðinti informacijos.



Patei kiamas dokumentas
vieðinimui (iõskyrus

informacijq, ku rios atskleidimas
negalimas pagalAsmens

duomenq teisinés apsaugos
istatymq)16

TAIP

Pateikiamas dokumentas
skirtas Paraiëkos ir/ar
kvalifikacijos atitikimo

ivertinimuil5

TAIP

lnformacija gali büti laikytina konfidencialia,
iðskyrus atvejus, jeigu atitinkama
informacija skelbiama viesai arba tiekejas
nurodo, kad nêra konfidencialu.

lnformacija gali büti laikytina konfidencialia,
i5skyrus atvejus, jeigu atitinkama
informacija skelbiama vieöai arba tiekêjas
nurodo, kad nera konfidencialu.

c lnformacija laikytina konfidencialia

Kokiu pagrindu atitinkamas
dokumentas yra (ne)konfidencialus?

lnformacija gali büti laikytina konfidencialia,
iðskyrus atvejus, jeigu atitinkama
informacija skelbiama vie5ai arba tiekejas
nurodo, kad nèra konfidencialu.

Ar dokumentas
konfidencialus?

(Taip / Ne)

Taip / Ne

Taip / Ne

Taip / Ne

Taip
Deklaracija del jungtinei veiklai
susivien ijusiq tiekejq grupês
dalvvavimo pirkime

U2pildytos formos ir kita
pateikiama informacijala

Prekiq atitikties Technines
specifikacijos reikalavi mams
lentelê

Jungtinês veiklos sutartis (jei
Parai5kq pateikia Tiekéjq grupe)

Kartu su Pasiülymu pateiklama
dokumentacija, kurioje yra
pateikti medZiagq ir jrenginiq
techniniai apra5ymai

4

Eil.
Nr.

1

2.

3

Visas Dalyvio Pasiulymas negali büti laikomas konfidencialia informacija.

Tuo atveiu. iei lentelé ar atskiros ios eilutès nèra u2pildomos. Pirkèias laikvs. kad ta Pasiülvmo informaciia arba atitinkama ios dalis nèra laikoma konfidencialia.

informacija yra nekonfìdenciali.
14 Atsk¡r¡ dokumentai ar Siuose dokumentuose pateikiama informacija gali bùti nurodoma atskirose eilutése, atsiZvelgiant j informacijos konfidencialumq.
15 Dokumentas ikeliamas: INSERT -> Object -> Create From File -> Browse -> Display as icon -> ok.

néra konfidencialios ir negalimos vieðinti informacijos.



Proküristas Kçstutis 

(Tiekejo arba jo igalioto asmens pareigos, , para5as) 17

ristas 

arba jo jgalioto asmens pareigos, vardas, pavarde, paraSas) 18

17 Jei Pasiülymq Pirkimui pasiraðo vadovo igaliotas asmuo, prie Pasiúlymo turi búti pridètas ra5ytinis igaliojimas arba kitas dokumentas, suteikiantis paraðo teisç.
18 Je¡ Pasiulymq Pirkimui pasiraðo vadovo lgaliotas asmuo, prie PasirJlymo turi bùti pridetas raðytinis igatiojimas arba kitas dokumentas, suteikiantis paraso teisg.



Priedas Nr, 3 prie Pasiülymo formos

PREKTU ATrïKTTES TEC HNINËS SPECIFIKACIJOS REIKALAVIMAMS LENTELË

Konkretüs sitilomq Prekiq
parametrai, pagrindåiantys

atitikimq

Dydis, sqlygaEit.
Nr.

Techniniai parametrai ir reikalavimai

Prekès gamintojas, tipas, modelis: ABB, 

TAIP,

(GAMrNrrJ ATTTTNKANÖ|U AB
ENERGIJOS SKIRSTYMO
OPERATORIUS TECHNINIUS
RETKALAVTMUS SARASO
NR.11.1.1

LST EN 62271-1, LST EN 62271-100,

LST EN 62271-200 arba lygiaveröiai

1 Standartai

TAIP,

(GAMTNTU ATTTTNKANÖTU AB
ENERGIJOS SKIRSTYMO
OPERATORIUS TECHNINIUS
RETKALAVTMUS SARASO
NR.1'1.1.1

2 Tipiniai bandymai turi buti atlikti ES akredituotoje laboratorijoje. Akredituota
laboratorija laikoma tokia laboratorija, kuri yra akredituota Europos akreditacijos
organizacijos (European co-operation for Accreditation) pripaZistamoje akreditacijos

[staigoje bandymq (testing) srityje.

Tipiniq bandymq protokolq i5davusi organizacija turi búti akredituota atlikti bandymus,
pagal aktualiq standartq redakcijq. Organizacijai akreditacijq suteikçs biuras turi büti
pilnavertis Europos akreditacijos organizacijos (angl. EA) narys. Pilnaverðiq (angl.
Full member) nariq sqraðas: http://www.european-accreditation.orq/ea-members

UZsakomq parametrq parinkimo sqraéas Nurodoma uZsakant:

LLTsNarvelio
ounktas)

konfiguracija (18 LLTs

TAIPPrie linijinio narvelio jungiamq kabeliq konstrukcija ir skerspjuvis:

- Trigyslis kabelis su bendru i5oriniu apvalkalu ir vieliniu ekranu, 120 mm2i
- Trigyslis kabelis su bendru iöoriniu apvalkalu ir vieliniu ekranu, 240 mm2;
- Viengyslis kabelis su vieliniu ekranu, 120 mm2i
- Viengyslis kabelis su vieliniu ekranu, 240 mm2.

Pastaba:

t.

2.

skirstykla turi büti sukomplektuota su visq nurodytq kabeliq tipq laikikliais -
konstrukcijomis;
skirstvklai 10 kV movos bei ribotuvai nekomplektuojami.

TAIPNuotolinis skirstyklos valdymas
(23 ounktas)

10 kV skirstykla be nuotolinio
valdvmo

3

TAIPUZdaroje neðildomoje patalpoje4 Skirtas naudoti

_ZS ... + 40Aplinkos temperatura Ne siauresnése ribose kaip nuo -25 "C
lki+35 "C

5

TAIPs 95 o/o6 Santykinè oro drégmé

1000 m7 Pastatymo aukðtis virö júros lygio < 1000 m

,10 KV10 kvI Vardiné tinklo itampa

12 kVMaksimalioji [tampa >12kVI
75 KV>75kV10. lmpulsinè bandymo jtampa (1,2/50 ¡,rs)

28 kV>28kV11 Bandymo itampa (50 Hz, 1 min.)

50Hz12 Vardinis daZnis 50 Hz

TAIPlzoliuota13. Tinklo neutralè

PMPertvarq klasê PM14.

AFL 16 kA 1s
AFL 16 kA 1s15. Vidinio lanko klasé (angl. lnternal arc

classification)

lP 2x16. 10 kV narveliq priekines panelês apsaugos
laipsnis

> IP2X

tP 6710 kV modulio su SF6 dujq izoliacija
> tP65.

17 Apsaugos laipsnis



Arba '10 kV hermetinio modulio oro
izoliaciia > 1P65.

18. Narvelíq konfigüracija:
L-linijinis narvelis
Ts-galios transformatoriaus narvelis (su saugikliais)

Pastaba:
Galimas kitoks pasirinktos konfigüracijos narveliq eiliðkumas (iödéstymas).

Su 1 galios transformatoriumi transformatorinéms iki 630 kVA:

LLTs;

Skirstyklq konfigüracijos su 1 galios transformatoriaus narveliu apjungiamos i
vienq bakq (narveliq galios skyrikliai, iZemikliai yra bendroje SF6 arba
hermetizuoto oro kapsuléje - bake).

Pastaba:

Galimas kitoks pasirinktos konfigüracijos narveliq eiliökumas (iödêstymas).

LLTs (CCF)

630 A; 630 A;10 kV linijinis narvelis (L narvelis).
Techniniai reikalavimai:
- Galios skyriklio-jZemiklio vardinê srovè,

Ir

630 A;- Atjungimo geba esant pilnai apkrovai 630 A;

- ljungimq-i5jungimq ciklq skaicius esant
vardinei srovei (C-O)

>100 cikkt; 100 ciklrt;

'1000 ciklr.t;- ljungimq-iSjungimq
mechaninis resursas

(C-O) ciklq >1000 ciklr¿;

16 kA;- Galios skyriklio ir iZemiklio vardiné
trumpoio iunqimo srové, /x (1 s)

16 kA;

40 kA;- Galios
srové, /o

skyriklio ir iZemiklio smuginé 40 kA;

40 kA;- Galios skyriklio ¡ungimo i trumpq.li
iunqima srove. /'"

40 kA;

5 kartai;>5 kartai;- Galios skyriklio ir lZemiklio ¡jungimo i
trumpaii iunqima ciklu skaiðius

TAIP- Galios skyriklio - iZemiklio pavara Rankinio valdymo su spyruoklêmis
palengvinanöiomis jjungimq

TAIP- Galios skyriklis - i2emiklis Trijq padèöiq (darbine- tarPinê-

iZeminta) arba dviejq padeöiq (darbine-

[Zeminta).

TAIP

TAIP
TAIP
TAIP

TAIP

TAIP

TAIP

TAIP
TAIP
TAIP

TAIP

TAIP

TAIP

19.

10 kV linijinio narvelio komplektavimas:
- Galios skyriklis SF6 dujq aplinkoje arba galios skyriklis hermetizuoto oro

aplinkoje;
- lZeminimo peiliai;
- 1 klasès kiétukiniai ribotuvai (pagal techninius reikalavimus);
- ,,C" tipo ekranuotos kiðtukines movos (pagal techninius

reikalavimushttp://w,rnv.eso.IUlUpartneriams/elektros-darbu-tiekejams-ir-
rangovams/projektu-techniniai-reikalavimai.html reikalavimo Nr.10.2.1);

- ltampos kabelyje indikatorius montuojamas priekinéje narvelio dalyje (itampos
buvimo/nebuvimo visose fazêse kontrolei ir indikacijai, su kabeliq fazavimo
galimybe);

- Trumpojo jungimo indikatoriai pagal techninius reikalavimus ,,10 kV trumpojo
jungimo indikatorius kabeliq tinklui su prijungimo prie TSPI galimybe", binarinis
iðejimas iðvestas ir prijungtas prie narvelio gnybtyno;

- Papildomi kontaktai signalizuojantys apie galios skyriklio padeti (2 NA-skyriklis

ijungtas; 2 NU-skyriklis iðjungtas), binarinis iðejimas iðvestas ir prijungtas prie
narvelio gnybtyno;

- Galimybè prijungti trigyslj kabel[ su vieliniu ekranu ir bendru i5oriniu apvalkalu;
- Narvelis prijungiamas '1 kabeliu;
- Narvelio gamintojo komplektuojama24Y DC variklinê pavan (su varikliu)su

visais reikalingais kontaktais, blokuotëmis ir valdymo i5 TSPI galimybe. Pavaros
darbas turi büti blokuojamas esant jjungtiems lZeminimo peiliams;

- 24V DC variklinê pavara komplektuojama tik su LLTs ir LLLTs narveliq
konfigüracijomis;

- Narvelio aptarnavimo kategorija LSC2.

Visi gnybtai su 4 rezervinémis vietomis, sumontuoti ant DIN begelio.

200 A20 10 kV galios transformatoriaus narvelis su
sauoikliais ffs narvelis).

200 A;



Techniniai parametrai:
- Galios skyriklio - iZemiklio vardinê

srové, /r

- Atjungimo geba esant pilnai apkrovai 200 A; 2004

- ljungimq-iöjungimq ciklq skaicius esant
vardinei srovei (C-O)

100 ciklq; 100 cikltt;

- ljungimq-iðjungimq
mechaninis resursas

(C-O) ciklq >1000 ciklq; '1000 ciklq;

- Skyriklio - iZemiklio pavara Rankinio valdymo su spyruoklèmis
palengvinanðiomis ¡ungimq

TAIP

- Skyriklis - iZemiklis Trijq padeciq (darbine- tarpinê-
iZeminta) arba dviejq padeöiq (darbine-

iZeminta).

TAIP

SF6
TAIP

TAIP

TAIP

TAIP

TAIP
TAIP
TAIP
TAIP

Narvelio komplektavimas:
- 10 kV galios skyriklis SF6 dujq arba hermetizuoto oro aplinkoje;
- 10 kV saugikliq lydieji ideklai (pagal techninius reikalavimus

http://www.eso.lVlVpartneriams/elektros-darbu-tiekejams-ir-rangovams/projektu-
techniniai-reikalavimai.html reikalavimo Nr. 1 3.2.3.);

- Narvelis pritaikytas 292 mm 10 kV saugikliq lydZiajam ideklui;- Esant kitokiam ldeklq ilgiui, turi buti komplektuojamas su adapteriu, kuris leidZia
naudoti 292 mm ilgio saugikliq lydZiuosius jdeklus;

- Narvelis komplektuojamas su apsauga nuo nepilnafazio rèZimo (perdegus bent
vienam saugikliq lydZiajam jdeklui atjungiamos visos 3 fazes);

- ,,4" tipo ekranuotos ki5tukinês movos (pagal techninius reikalavimus
http://wllw.eso.lt/lUpartneriams/elektros-darbu{iekejams-ir-rangovams/projektu-
techniniai-reikalavimai.html. reikalavimo Nr. 1 0.2.'l 3.));

- lZeminimo peiliai (saugiklis turi büti iZeminamas ið abiejq pusiq);
- Prijungi as viengysliais kabeliais;
- Talpines itampos kabelyje indikacija;

Narvelio aptarnavimo kategorija LSC2.

10 kV sekcinis narvelis (S narvelis)

Techniniai reikalavimai:

- Galios skyriklio-iZemiklio vardinê srovê,
t,

630 A

- Galios skyriklio ir iZemiklio vardiné
trumpojo jungimo srovê, lk ('1 s) 16 kA

- Galios skyriklio ir iZemiklio smüginé
srovè, /p

40 kA;

- Galios skyriklio ijungimo i trumpq.li
iunoima s[oVê. /ma

40 kA;

- Galios skyriklio ir iZemiklio ¡ungimo i
trumpaii iunqima ciklu skaiðius

>5 kartai;
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Narvelio komplektavimas:
- Galios skyriklis SFo dujq aplinkoje arba hermetizuoto oro aplinkoje;
- lZeminimo peiliai.
- Papildomi kontaktai signalizuojantys apie galios skyriklio padeti (2 NA-skyriklis

ijungtas; 2 NU-skyriklis isjungtas), binarinis iðejimas iðvestas ir prijungtas prie
narvelio gnybtyno;

- Narvelis turi buti su galimybe irengtoje skirstykloje imontuoti variklinç pavarq,
leidZianðia nuotoliniu büdu valdyti galios skyrikli;

- Narvelio aptarnavimo kategorija LSC2.

Visi gnybtai su 4 rezervinémis vietomis, sumontuoti ant DIN begelio.

Narveliq iðpletimas Be narveliq iðpletimo galimybes
ateityje.

Be narveliq iSplétimo galimybes
ateityje.

22

23 Kabeliq prijungimas prie narveliq.
Montuojamos movos turi büti pilnai suderinamos su konkretaus gamintojo narveliais.
Pateikti narveliq gamintojo sudarytq tinkamq montuoti kiðtukiniq movq sqra5q.
- Linijiniai narveliai prijungiami su ekranuotomis kiðtukinémis movomis (adapteriais)

,,C" tipo pagal LST EN 50181 arba lygiavertf (pagaltechninius reikalavimus
http://www.eso.lVlUpartneriams/elektros-darbu-tiekejams-ir-rangovams/projektu-
techniniai-reikalavimai.html reikalavimo punkto Nr.10.2.1.);

- Galios transformatoriq narveliai prijungiami su ekranuotomis kiðtukinemis movomis
(adapteriais),,4" tipo pagal LST EN 50181 arba lygiavertj (pagal techninius
reikalavimus,,A" tipo movoms http://www.eso.lt/lt/partneriams/elektros-darbu-
tiekejams-ir-rangovams/projektu-techniniai-reikalavimai.html reikalavimo Nr.

10.2.13\.

TAIP

TAIP



24 Narveliai komplektuojami Su gamyklinemis jZeminimo ðynomis ir
jungtimis sujungimui su linijos iZemikliu

TAIP

25. Kabelio tvirtinimas Specialiomis apkabomis prie narvelio
pagrindo pertvaros

TAIP

TAIP
26. Moduliq izoliacijos indikacija:

- Su SF6 dujq izoliacija: slegio indikatorius (manometras) su skale, leidZianðia
identifikuoti ar SF6 dujq slegis yra pakankamas saugiam [renginio eksploatavimui,
slêgio indikatorius su NA kontaktu signalo perdavimui iTSPl, ièvestas ir prijungtas
prie narvelio gnybtyno.

- Su hermetizuoto oro izoliacija: indikacija, signalizuojanti apie oro arba drégmès
patekimq iö aplinkos. lndikatorius su NA kontaktu signalo perdavimui i TSPI,
iðvestas ir priiunqtas prie narvelio qnvbtvno.

27 Priemonés slégiui sumaZinti (Narveliams
su SF6 dujomis)

Turi büti techninés priemonés slégiui
sumaZinti

TAIP

28 Gamykloje narveliai turi búti pilnai surinkti
ir sukomplektuoti

Pateikti narvelio
protokolus

tikrinimo-bandymo TAIP

TAIP29. Itampos indikacija Narvelio fasade

30. Blokuotès:
- Galios skyriklis mechaniðkai blokuotas, jei ljungtas jZemiklis;
- lZemiklio ijungimas mechaniðkai blokuotas, jei ijungtas galios skyriklis;
- Narvelio durvs blokuoiamos. kai vra neiiunqtas iZemiklis.

TAIP

TAIP31 Mnemoschema lSpildyta ant narvelio fasado

TAIP32. UZrasai (lietuviq kalba) UZrasai derinami projektavimo metu

(Pagal techninius reikalavimus
norminius dokumentus)

TAIP33 Antriniq grandiniq laidai Turi turêti Zymenis

TAIP34 Skirstykla pateikiama VisiSkai sukomplektuota prijungimui
prie tinklo.

Durq spynos, spynelés ir raktai Vienodo tipo kitq skirstyklos narveliq
durq atZvilgiu.

TAIP35

> 30 metq 30 metq36 Tarnavimo laikas

24 ménesiai37 Garantinis eksploatavimo laikas > 24 ménesiai

Ne daZniau kaip kas 6 metai Ne daZniau kaip kas 6 metai38 ApZiürq periodiðkumas

Prokúristas 

(Tiekejo arba jo jgalioto asmens pareigos, raöas)1e

üristas 

a jo jgalioto asmens pare¡gos, vardas, pavarde, paraðas)2o

le Jei Pasiülymq Pirkimui pasira5o vadovo jgaliotas asmuo, prie Pasiúlymo turi búti pridetas raöytinis igaliojimas arba kitas dokumentas, suteikiantis
paraéo teisç.
20 Jei Pasiúlymq Pirkimui pasiraðo vadovo igaliotas asmuo, prie Pasiülymo turi büti pridétas raðytinis igaliojimas arba kitas dokumentas, suteikiantis
paraéo teisç.




